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Intoroduction

Introduction

Operating
Environment
Computer

Personal computer running Windows 95, Windows 98, or
Windows NT 4.0

CPU
If you're using Windows 95
i486SX or better (Pentium 100 MHz or more recommended)
If you're using Windows 98 or Windows NT 4.0
i486DX or better (Pentium 100 MHz or more recommended)

Memory
If you're using Windows 95
8 Mbytes or more (16 Mbytes or more recommended)
If you're using Windows 98 or Windows NT 4.0
16 Mbytes or more (32 Mbytes or more recommended)

Hard disk
A hard disk with at least 5 Mbytes of free space is required.

Overview of Dr.
STIKA PLUS

Dr. STIKA PLUS is a Windows 95, Windows 98, Windows NT
4.0 application for making stickers.

<Main Features of Dr. STIKA PLUS>
• Text outlining (TrueType fonts)
• Changing the thickness (weight) of text
• Creating squares, circles, stars, and other shapes
• Inserting and registering a symbol
• Editing shapes and text (objects)

- Changing the size of an object
- Rotating an object
- Slanting an object to the left or right
- Flipping the object laterally (Mirror function)
- Editing the points (apices) of a polygon

• Precise object positioning (Show Grid function)
• Tiled cutting for sizes larger than the cutting area (Tiling

function)
• Importing image data from image scanners with TWAIN

support
• Importing files in BMP (Windows bitmap) format (Bitmap

Trace function)



5

Intoroduction

Names and Functions of Screen Items
(10) (11) (12)

(8)

(1)

(2)

(3)

(4)

(7)

(6)

(5)

(1) Title bar
The file name and program name are displayed here.
The window can be moved by dragging the title bar.

(2)Menu Bar
Runs the various commands for Dr.STIKA PLUS.

(3) Toolbar
The toolbar is provided with buttons for running Dr.STIKA PLUS
commands such as [Open...] and [Save]. Moving the mouse
pointer over a button displays a brief description of the button's
function.

(4) Cutting direction
This shows the direction of cutting with respect to the cutting
machine.

(5) Cutting Area
This white square indicates the cutting range set by the driver.
Objects that extend beyond this area are not cut.

(6) Object Information Bar
This shows the location of the mouse pointer, as well as the
centerpoint, size, angle, and slant of the object.

(7) Status Bar
This shows the type of text font, line color, and amount of zoom
in or zoom out for the image.

(9)

(8) Object
This is a shape or a block of text to be cut.

(9)
When the mouse pointer is moved close to here, the pointer
changes to a diagonal arrow.  You can then change the window
size by dragging.

(10) Minimize button
This shrinks the window to a button on the taskbar.

(11) Maximize button
This expands the window to fill the screen.

(12) Close button
This ends the program.
If changes made to the file being edited have not been saved, a
dialog box asking if you wish to save the changes is displayed.



Operating
Procedure
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Operating Procedure

Introduction
The basic operation of Dr. STIKA PLUS is covered in the
explanation of the procedures from step 2 to step 9. This section
describes how to cut the sticker shown in the figure.

Step 1: Set the
cutting area

Set the cutting area to match the size of the material loaded.
The cutting range that has been set becomes the editing area for
Dr. STIKA PLUS. The editing area is represented by a shadowed
white rectangle. A sticker is designed by arranging shapes and text
in the editing area. Portions that extend beyond this area are not
cut.

The material loaded on the cutting machine has some places that
cannot be cut, such as the portion that passes under the
pinch rollers and the portion corresponding to the length required
for sheet feed.
Set values for the cutting area that are smaller than the size of the
loaded material.
The cutting area varies from one model to another. For more
information, see the user's manual for the cutting machine
you're using.

1. From the [File] menu, click [Print Setup...]. The [Print Setup]
dialog box is displayed.

2. For [Printer], click [Name], then choose the driver to be used
for output.

3. Click [Properties].
The driver's properties open.

4. Set the cutting range.

5. Click [OK] to close the [Size] tab. The click [OK] again to
close the [Print Setup] dialog box.

6. The next step is to set the cutting conditions.
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Step 2: Set the
cutting
conditions

Set the transfer speed of the blade and the tool offset to match the
type of blade installed and the type of material loaded. This
section describes the procedures to set [Machine Setting]. For
more details about setting the cutting conditions, refer to the help
screens for the driver.

3. Click [OK].

Step 3: Enter the
text

Enter the block of text to be cut.
The text that is input is displayed as outlined text. Only TrueType
fonts registered with Windows can be used with Dr. STIKA PLUS.
Here we'll input SALE as the block of text.

1. Click the  button.
The mouse pointer changes to the cursor for the text-editing
tool (  ).

2. Click at the start point for entering the text.

3. Type in SALE from the keyboard.

1. Click the   button.
The mouse pointer changes from the text-entry tool (  ) to the

selection tool (  ).

2. Click on the SALE text.
Editing points (  and   ) appear around the text.

3. Drag a  with the mouse.
The size of the text changes as the mouse moves. Here, change
the text to a size that fills the white area, as shown below, then
release the mouse button.

4. To deselect the text, click on an area other than the text.

Step 4: Change the
size of the
text

Change the size of the text.
In this section we'll enlarge the size the SALE text to match the
size of the material.

1. At the driver's Properties, click the [Tool] tab.

2. Click [Setting], and choose [Machine Setting].
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Step 8: Start cutting
Operate Dr. STIKA PLUS and start cutting. Before cutting, check
the cable connections, the loading of the material, and the
installation of the blade. For more details, please refer to the user's
manual for the cutting machine.

1. Click the   button.
The [Print] dialog box appears.

2. Click [OK].
The cutting data is sent to the cutting machine, and cutting
starts.

To cancel cutting before it's finished
1. On the cutting machine, switch off the power.

2. On the computer, click [Start].

3. Point to [Settings] and click [Printers].

4. Double-click the icon for the printer driver.

5. From the [Printer] menu, click [Purge Print Jobs]. The file
being cut is deleted from display. When the file being cut is
not displayed, it means that the data has already been sent.

Step 7: Save the file
Save the data that's been created to a file.

1. Click the  button.

The [Save As] dialog box appears.

2. Enter the name of the file and click [Save].

Step 6: Make a
square frame

The sheet can be made easier to peel after it has been cut by
cutting all around the shapes and text. In this section we'll draw a
rectangular frame to enclose the SALE text.

1. Click the   button.

The mouse pointer changes from the selection tool (   ) to the
shape-drawing tool (   ).

2. Drag the pointer as shown in the figure.

Step 5: Choose a
font

Choose a font for the entered text.
With Dr. STIKA PLUS, you cannot use any font other than
TrueType fonts registered in Windows. When selecting a font,
only TrueType fonts are listed.

1. Click on the text to select it.

2. From the [Object] menu, click [Font...]. The [Font Select]
dialog box is displayed.

3. Click on the font name to select it.
Here, we'll select Arial.

4. Click [OK].

Step 9: Apply the
sticker

Apply the sticker that's been cut it the desired location. Applica-
tion tape is used to apply the sticker.

1. Remove the material on the cutting machine.

2. Peel off the excess parts of the sheet. It may be easier to peel
off detailed portions of the cut sheet using ordinary tweezers
(not included).

3. Cover carefully with application tape so that no air is trapped
between, and transfer the sheet to the tape.

4. Carefully wipe away any grime (dust or oil) on the place
where the sticker is to be applied.

5. Apply the application tape with the sticker to the desired site,
and press from above. A commercially available squeegee can
be used to apply the sticker attractively, with no air bubbles
under the sheet. Make sure the sticker is affixed to the target
object, then slowly peel off the application tape.



Basic
Operations for

Objects
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Basic Operations for Objects

Selecting more than object
• While holding down the [Shift] key, click on each of the

objects you wish to select.
• Drag the mouse to enclose entirely the object you wish to

select.

Canceling the
selection of an object

1. Click the  button.

2. Click on an area other than the selected object.

Selecting an object

1. Click the  button.

2. Move the mouse cursor to the object (shape or text) to be
selected, and click the mouse.

3. The symbols   and   appear around the selected object.

Moving an object
horizontally or
vertically

1. Click the  button.

2. Click on the object to select it.

3. While holding down the [Shift] key, drag the object up, down,
or to the left or right.

The triangular points (  ) on the left and right can be dragged
to change the horizontal size.

Making an object
larger or smaller

1. Click the  button.

2. Click on the object to select it.

3. Change the size of the object by dragging the points (   and

 ) that appear around the object.

The size can be freely changed by dragging a square point ( 
.)  The size can be changed while maintaining the shape's
vertical and horizontal aspect by holding down the [Shift] key
while dragging.

The triangular points (  ) above and below can be dragged to
change the vertical size.
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Rotating an object

1. Click the   button.

2. Click on the object to select it.

3. Click on the object again.
The points around the object change to circles and diamonds

(   and   ).

4. Drag a circular point ( ) to rotate the object around its
center.

Slanting an object
1. Click the   button.

2. Click on the object to select it.

3. Click on the object again.
The points around the object change to circles and diamonds
(  and  ).

4. Drag a diamond point (  ) to slant the object.

Copying an object

1. Click the  button.

2. Select the object to be copied by clicking on it.

3. Click the  button.

4. Click the  button.
The new object is copied overlapping the source object.

5. Select the copied object and drag it to the desired location.

Deleting an object

1. Click the  button.

2. Select the object to be copied by clicking on it.

3. From the [Edit] menu, click [Delete].



Hints and Tips
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Hints and Tips

Changing the size
without altering the
centerpoint
To change the size without altering the position of its centerpoint,
hold down the [Ctrl] key and drag an editing point (  and  ).

1. Select the object

2. While holding down the [Ctrl] key, drag a point (  and  ).

The size can be freely changed by dragging a square point ( 
).
The size can be changed while maintaining the shape's vertical
and horizontal aspect by holding down the [Shift] key while
dragging.

The triangular points (  ) on the left and right can be dragged
to change the horizontal size.

The triangular points (  ) above and below can be dragged to
change the vertical size.

Shapes Unsuitable
for Cutting
The following shapes are not suitable for cutting. This should be
kept in mind when creating shapes with Dr. STIKA PLUS.

Partially overlapping shapes
Data like that in the figure below, where two shapes partially
overlap, is not suitable for cutting. Objects should be arranged so
that shapes do not overlap.

  Related Topics
Making an object larger or smaller

Even in cases of overlapping shapes, a shape that is completely
enclosed inside another is suitable for cutting.
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Creating a shape with
the same vertical and
horizontal aspect
To create a shape with a vertical/horizontal aspect of 1:1, such as a
circle or square, drag while holding down the [Shift] key. This
function is not supported when creating text or a polygon.

1. Click the button for creating a rectangle, round rectangle,
circle or ellipse, or star.

2. While holding down the [Shift] key, drag the object.

Creating a shape
with the drag start
point as the center
To create a shape with a shape's start point the centerpoint, drag
while holding down the [Ctrl] key. This function is not supported
when creating text or a polygon.

1. Click the button for creating a square, rounded-corner square,
circle or ellipse, or star.

2. While holding down the [Ctrl] key, drag the object.

  Related Topics
Making an object larger or smaller
Text properties [Keep Aspect for input]
Polygon properties[Keep Aspect for input]

  Related Topics
Creating a shape with the same vertical and horizontal aspect

Editing the points
(apices) of a polygon

You can use the polygon edit button (  ) to add, delete, or
move the points in a polygon.

Basic operations for editing a polygon

Selecting a point

1. Click  .

2. Click on the polygon.

3. Click on the point.
The selected point changes to a square with a border (   ).

Selecting a number of points

1. Click  .

2. Click on the polygon.

3. Hold down the [Shift] key and click on each point (  ).
Alternatively, drag the mouse over the points to be selected.
Each selected point changes to a square with a border (  ).

Selecting a segment

A polygon shown as a series of continuous lines is called a
segment.

1. Click  .

2. Click on the polygon.

3. While holding down the [Ctrl] key, click on one point (  ) on
the segment. All of the segment's points change to a square
with a border (  ).

4. To select a number of segments, hold down the [Shift] key and
the [Ctrl] key and click on each point (  ).
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Selecting an object
hidden under
another object
All objects maintain a certain front-to-back relationship when
they overlap. This hierarchy depends on the sequence in which the
objects were created, with newer objects existing more to the
front than older ones. When a smaller object lies behind a larger
one, the smaller object cannot be selected. To select the smaller
object, change the front-to-back relationship of the larger and
smaller objects. This front-to-back relationship between objects
can be changed at any time.

1. Select the large circle on top

Moving a point

1. Click  .

2. Click on the polygon.

3. Drag the point (  ).

When a number of points have been selected, you can move
them as a set while still maintaining their positions in relation
to each other. To move a number of points, drag any one of the
selected points (  ).

Adding a point

1. Click   .

2. Click on the polygon.

3. Move the mouse pointer over a line of the polygon, then click.
A (  ) appears where the point will be added.

4. Press [Insert].

Deleting a point

1. Click  .

2. Click on the polygon.

3. Click on the point.
The selected point changes to a square with a border (  ).
To delete two or more points at the same time, hold down the
[Shift] key as you click on each point (  ). Alternatively, drag
the mouse over the points to be deleted.

4. Press [Delete].

 Related Topics
Convert to Polygon
Combine Polygon
Break Apart

2. Click the  button.
The large circle moves to the bottom.

3. Select the small circle

To add a point using only the mouse, double-click on a line of
the polygon.
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Arranging a number
of objects
- Using Snap to Grid -
It's possible to use a grid as a guide for placing and sizing objects.
The grid is shown on screen with equal vertical and horizontal
spacing. When Dr. STIKA PLUS has just been installed, the grid
is shown with a spacing interval of 5 mm. To align an object with
the grid, from the [View] menu, activate [Snap To Grid].

1. Create the object at any location.

2. From the [View] menu, select [Snap To Grid].

3. Select the objects one at a time, and move each object toward
the grid at the desired location. The object is automatically
pulled to the grid and aligned.

Aligning the centers
of a number of
objects
It's necessary to align objects at their centers when making a
sticker that has text surrounded by a border, or when creating
centered text.

Aligning objects at their centers

1. Create the objects at any location.

2. Select all of the objects whose centers you wish to align.

3. From the [Object] menu, click [Align]. The centerpoints of the
selected objects are all aligned.

Centering text

1. Create two or more blocks of text, then carry out steps 2 and 3
for "Aligning objects at their centers."

 2. Select one block of text, and while holding down the [Shift]
key, drag the selected text up or down. Follow the same
procedure to align the other blocks of text.

 Related Topics
Moving an object horizontally or vertically

 When the text blocks are aligned with the left-hand edge

 Related Topics
[Grid Setup...] command
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Creating regular
polygons
A regular polygon can be created by first making a circle, then
modifying it.

Using symbols
Dr. STIKA PLUS is provided with a set of symbols. Symbols can
be added to a file being edited, or registered with Dr. STIKA
PLUS objects.

Importing a symbol
1. From the [Object] menu, click [Symbol].

The [Symbol] dialog box appears.

2. Select the group, then click on the symbol to be added.

3. Click [Insert].

4. Adjust the size and position of the symbol to be placed.

Registering a symbol
1. Select the symbol to be used, and click [Insert].

2. From the [Object] menu, click [Symbol].
The [Add Symbol] dialog box appears.

3. Register the symbol with an appropriate group according to
use or shape. To create a new group, click [New Group] and
enter a name for the group. When adding the symbol to an
existing group, select the group name with [Group Name].

4. At [Symbol Name], enter a name for the symbol. Then click
[Add].

1. Click the  button.

2. While holding down the [Shift] key, drag the mouse to create a
circle.

3. Select the circle, then from the [Object] menu, click [Proper-
ties]. The [Circle or Ellipse Properties] dialog box appears.

4. Drag the [Shape] slider.
You can make any regular polygon having from three sides (an
equilateral triangle) to thirteen. Dragging the slider to the
right-hand edge creates a circle instead of a polygon.
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Conditions for data that can be pasted
- Don't include bitmap data
- Don't fill or apply shading inside shapes
- Set line width to the finest (narrowest) available setting

Making use of
existing Dr. STIKA
PLUS data
An object saved in another file can be added to the file for the
object now being edited. This makes it possible to re-use objects
that have been previously created and saved.

1. From the [File] menu, click [Import...]. The [Open] dialog
box appears.

2. Click [Files of type] and select [Dr. STIKA Files (*.stx)]. A
list of files that can be imported is shown.

3. Select the file and click [Open].

4. The imported objects are shown on screen. The newly
appearing data can be edited in the same way as ordinary
data.

Pasting a graphic
created with
commercial software
into Dr. STIKA PLUS
You can copy data created with software such as CorelDRAW!
that uses vector data, and paste the data into Dr. STIKA PLUS
using the clipboard. The data pasted in can then be edited just like
any ordinary object.

  Related Topics
[Import] command

1. After using a commercial software application to create data,
select the data and copy it.
For information on how to create data with the commercial
software application, refer to the documentation for the
software you are using.

2. From the [Edit] menu, click [Paste]. The copied data appears
in Dr. STIKA PLUS.

* Depending on the program, it may not be possible to paste
data even if it meets the preceding conditions.
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Using a scanner to
import an object
An image acquired with a scanner can be imported into Dr. STIKA
PLUS and outlined for cutting. Dr. STIKA PLUS supports
scanners that comply with TWAIN_32. For information on
connecting the scanner and installing the scanner driver, please
refer to the scanner's documentation.

Some images cannot be outlined easily, or may produce shapes
that are not suitable for cutting. Please keep the following
conditions in mind when creating data.

Conditions for data that yields
attractive cutting results

- Boundaries between two colors should be sharp and
well defined, with no continuous gradations. Using only the
two values of white and black is recommended.
(Scanned data for photographs generally contains continuous
gradations, making it unsuitable for cutting.)

Example

- The scan resolution should be high.
(In general, a higher resolution yields outlining of greater
accuracy. The optimal resolution varies according to a shape's
complexity and size when cut. However, it takes longer to
import high-resolution data into Dr. STIKA PLUS than low-
resolution data.)

Example

- The size of the original art being scanned should be the
same as the size when cutting.
(Results of cutting that are more attractive than the original art
are not obtained when an image smaller than the cut image is
imported and then enlarged with Dr. STIKA PLUS. To help
ensure attractive results of cutting, start with a larger object
and reduce it to the desired size.)

1. From the [File] menu, click [Select Source...].

2. Select the driver for the scanner.
If a TWAIN driver and a TWAIN_32 driver are both installed,
select the TWAIN_32 driver.

3. Load the original document on the scanner.

4. From the [File] menu, click [Acquire...]. Launch the scanning
software. For information on how to do this, please refer to the
documentation for the scanner.

5. When the scanning is finished, the scanned data is imported
into Dr. STIKA PLUS. The [Preview] dialog box appears.
Make sure the information in the dialog box is correct and
click [OK].

6. Check the scanned data in the [Preview] dialog box and click
[OK].

7. The outlined object appears on screen.

8. Adjust the size of the objects as needed.

  Related Topics
Making an object larger or smaller
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Conditions for data that yields
attractive cutting results

- Boundaries between two colors should be sharp and
well defined, with no continuous gradations. Using only the
two values of white and black is recommended.
(Scanned data for photographs generally contains continuous
gradations, making it unsuitable for cutting.)

Example

- The scan resolution should be high.
(In general, a higher resolution yields outlining of greater
accuracy. The optimal resolution varies according to a shape's
complexity and size when cut. However, it takes longer to
import high-resolution data into Dr. STIKA PLUS than low-
resolution data.)

Example

- The size of the original art being scanned should be the
same as the size when cutting.
(Results of cutting that are more attractive than the original art
are not obtained when an image smaller than the cut image is
imported and then enlarged with Dr. STIKA PLUS. To help
ensure attractive results of cutting, start with a larger object
and reduce it to the desired size.)

1. From the [File] menu, click [Import...]. The [Open] dialog box
appears.

2. Click [Files of type] and select [Windows Bitmap File
(*.bmp)]. A list of files that can be imported is shown. Select
the desired file and click [Open...].

3. The data is read into the preview screen and displayed. Check
the contents and click [OK]. When importing a color image,
outlining may not proceed as expected, depending on the
colors. In such cases, drag the [Adjust Image Density] slider to
adjust the image, or refer to the "Conditions for data that
yields attractive cutting results" to correct the data using a
commercial software application.

4. The outlined object appears on screen.

5. Adjust the size of the objects as needed.

Importing bitmap data
Dr. STIKA PLUS support import for files in Windows bitmap
format (which have the file extension *.bmp). For information on
how to save a file in Windows bitmap format, please refer to the
documentation for the software application.

Some images cannot be outlined easily, or may produce shapes
that are not suitable for cutting. Please keep the following
conditions in mind when creating data.

 Related Topics
[Import] command
Making an object larger or smaller
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Outputting data larger
than the cutting area
The Tiling function is used when cutting data that exceeds the
maximum cutting area on a single piece of material. Using the
Titling function lets you set a cutting area that is twice the size of
the cutting area set with the driver. The data is split and is cut on
two pieces of material.

When tiling is used, a line is cut between the right-hand edge of
the first page and the left-hand edge of the second page, as in the
tiled output shown in the figure.

This is done to close any shapes that extend across the first and
second pages. The cut length of this line is the length for the
cutting area that has been set for the driver. This means that
loading material that is shorter than the cutting range may result in
the material coming loose during cutting. Be sure to load material
that is longer than the cutting range that has been set.

1. The two pages of material are shown divided by a dotted line.

2. Create the cutting data.

3. Click the  button.
A message appears, prompting you to load the material.

4. Load the material for the first page and click [OK].

5. When finished sending the data for the first page, Dr. STIKA
PLUS displays a message prompting you to change the
material. Make sure the cutting machine has stopped operation
and load the second piece of material.

6. After changing the material, click [OK]. The cutting for the
second page starts.

* For information on how to apply pages that have been tiled,
please refer to the user's manual for the cutting machine.

Performing a draft
plot before actual
cutting
Draft plotting is used to plot a design on paper instead of cutting it
into material, thereby enabling the cutting results to be verified
before actual cutting is performed. The results of draft plotting can
be examined to make any necessary corrections in the data before
actually cutting the material.

1. Install a pen and load paper. For more information on how to
do this, please refer to the user's manual for the cutting
machine.

2. From the [File] menu, click [Print Setup...]. The [Print Setup]
dialog box appears.

3. For [Printer], click [Name], then choose the driver to be used
for output.

4. Click [Properties].
The driver's properties are displayed.

5. Click the [Tool] tab.

6. In the [Setting] box, click on the down-pointing arrow, then
click on a number other than the one for [Machine Setting].

7. Click [Draft Plot] to activate the setting, then click [OK]. The
[Print Setup] dialog box appears.

8. Click [OK] to finish making the settings.

9. Click the  button.
The cutting machine starts to operate.

To perform cutting after the draft plot has finished, repeat steps 2
through 6 to make the appropriate settings for [Machine Setting].



Commands
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[File] - [New] command
This creates a new file.
If changes made to a file being edited have not been saved, a
dialog box asking if you wish to save the changes is displayed.

 Keyboard shortcut: [Ctrl]+[N]

Commands - [File]
menu

(6)

(1) [Close] button
This closes the dialog box.

(2) [?] button
Clicking first this button, then the area which needs to be
explained, displays help for the area in question.

(3) [Open] button
If a file in the file list has been selected, click this button to
open the file.
If a folder has been selected, click this button to open the
folder and view its contents.

(4) [Cancel] button
This closes the dialog box.

(5)
Choose the area where the file has been saved.

(6)
The folders and files in the [Look in] are displayed.
Double-click on a file to open it.  Double-click on a folder to
open it and see the files inside.
(7)
Enter the file name.

(8)
Select the type of file.
Only files with the chosen extension are listed.  To list all
files, choose "All Files (*.*)."

[File] - [Save] command
This saves the file, overwriting the previous version of the file.
To save the file with a different name or in a different area, use the
[Save As...] command

  Keyboard shortcut: [Ctrl]+[S]

(1)

(2)

(4)(8) (7)

[Open] dialog box
(5)

(3)

[File] - [Open...] command
This opens a Dr.STIKA PLUS file.
Running this command opens the [Open] dialog box.
If changes made to a file being edited have not been saved, a
dialog box asking if you wish to save the changes is displayed.

 Keyboard shortcut: [Ctrl]+[O]
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 Related Topics
Making use of existing Dr. STIKA PLUS data
Importing bitmap data

[File] - [Import] command
This imports an existing Dr. STIKA PLUS file, or a file created
using another software application. Running this command makes
the [Open] dialog box appear.

[Open] dialog box

(1)
Choose the area where the file has been saved.

(2)
The folders and files in the [Look in] are displayed.
Double-click on a file to open it.  Double-click on a folder to
open it and see the files inside.

(3)
Enter the file name.

(4)
Select the type of file.
Only files with the chosen extension are listed.  To list all files,
choose "All Files (*.*)."
Files made with Dr. STIKA PLUS have ".stx" as their file
extension. You can usually leave the setting at [Dr. STIKA
Files (*.stx)].

(5) [Open] button
If a file in the file list has been selected, click this button to
open the file.
If a folder has been selected, click this button to open the
folder and view its contents.

(4) (3) (5)

(1)(2)
[Save As] dialog box

(1)
Choose the area where the file is to be saved.

(2)
The folders and files in the [Save in] are displayed.
Double-click on a folder to open it and see the files inside.

(3)
Enter the name for saving the file.
The extension selected for [Save as type] is appended to the
file name.

(4)
Select the extension for the file to be saved.
The file extension helps Windows determine the application
associated with the file.  Dr.STIKA PLUS files use ".stx" as
their extension.  Normally, this should be set to " Dr.STIKA
PLUS files (*.stx)."

(5)
[Save] button
This saves the file to the selected [Save in].

(4) (3)

(1)(2)

(5)

[File] - [Save As...] command
This saves the file with a different name.
Running this command opens the [Save As] dialog box.
Windows 95 long file names are supported.
Normally, ".stx" is used as the file extension.



26

Commands

[File] - [Print Preview] command
This displays what the results of printing will look like, so you can
check your work before actually performing printing. Running this
command changes the display from the object's edit screen to the
preview screen.

Preview screen commands
Print... This performs printing.  The [Print] dialog box appears.

Page Setup... This allows you to make settings for paper
size, margins, and the like.  The [Page Setup]
dialog box appears.

Zoom In This enlarges the view size of the print image.

Zoom Out This reduces the view size of the print image.

Close This closes the Preview screen for printing.

[File] - [Print Setup...] command
This is used to select the driver and make the setting for orienta-
tion. The [Print Setup] dialog box appears. To output data, then for
[Printer], click on the down-pointing arrow next to [Name], then
click on the driver to be used for output. To make settings for the
cutting area and the tool, click [Properties]. For more information
on the Properties settings, refer to the help screens for the driver.
The settings made here are temporarily saved. The changes are
lost when you quit Dr. STIKA PLUS.

Preview screen commands
Print... This performs printing.  The [Print] dialog box appears.

[File] - [Tiling] command
When the data is larger than the cutting area, this is used to split
the data for cutting on two pieces of material instead of one. When
the tiling output is set, the two pieces of material are displayed,
separated by a dotted line. The cutting area for a single piece of
material is set with the driver.

1 Page
This is selected when tiling is not to be performed.  When Dr.
STIKA PLUS is run for the first time, the setting in effect is for [1
Page]

2 Pages
This is selected when data that is larger than the cutting area is to
be split into two pages and output.

[File] - [Exit] command
This ends the program.
If changes made to the file being edited have not been saved, a
dialog box asking if you wish to save the changes is displayed.

 Shortcut:

 Related Topics
Outputting data larger than the cutting area 

Click the button for
closing the application
window.

[File] - [Select Source...] command
This selects the scanner connected to the computer. Dr. STIKA
PLUS supports scanners that comply with TWAIN_32. For
information on connecting the scanner and installing the scanner
driver, please refer to the scanner's documentation.

If a TWAIN driver and a TWAIN_32 driver are both installed,
choose the TWAIN_32 driver.

 Related Topics
Using a scanner to import an object

[File] - [Acquire...] command
This takes in the image from the scanner. The acquired image
can then be outlined with Dr. STIKA PLUS and cut. Running
this command launches the application for performing
scanning. For more information on operation, please refer to
the scanner's documentation.

 Related Topics
Using a scanner to import an object

[File] - [Print...] command
This takes the cutting data displayed on the edit screen and
outputs it to the cutting machine. Running this command
opens the [Print] dialog box. To output data, then for [Printer],
click on the down-pointing arrow next to [Name], then click
on the driver to be used for output. At the [Print] dialog box
you can make settings for the items such as the printing range,
orientation, and number of copies. To make settings for the
cutting area and the tool, click [Properties]. For more informa-
tion on the Properties settings, refer to the help screens for the
driver.

   Keyboard shortcut: [Ctrl]+[P]
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[Edit] - [Delete] command
This deletes the selected object. The deleted object is not copied to
the clipboard.

 Keyboard shortcut: [Delete]

[Edit] - [Select All] command
This selects all objects displayed on screen.

 Keyboard shortcut: [Ctrl]+[A]

[Edit] - [Undo] command
This erases the change just made and returns to the previous form.
Only the operation most recently performed can be undone.  It is
not possible to undo earlier changes.

 Keyboard shortcut: [Ctrl]+[Z]

[Edit] - [Cut] command
This deletes the selected object, and copies it to the clipboard. The
contents of the clipboard are maintained until another object is
copied to the clipboard. To paste the clipboard contents, run the
[Edit] - [Paste] command.

 Keyboard shortcut: [Ctrl]+[X]

[Edit] - [Copy] command
This copies the selected object to the clipboard. The contents of
the clipboard are maintained until another object is copied to the
clipboard. To paste the clipboard contents, run the [Edit] - [Paste]
command.

 Keyboard shortcut: [Ctrl]+[C]

Commands - [Edit]
menu

 Related Topics
Copying an object

[Edit] - [Paste] command
This copies the contents of the clipboard, pasting them at the
selected on-screen location. Only Dr. STIKA PLUS objects can be
pasted. Objects created with other applications cannot be pasted
via the clipboard.

 Keyboard shortcut: [Ctrl]+[V]

 Related Topics
Copying an object
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Commands - [View]
menu

[View] - [Zoom] - [Zoom In]
command
[View] - [Zoom] - [Zoom Out]
command

This enlarges or reduces the view of the object. Clicking the left
mouse button show an enlarged view with the point where clicked
at the center. The area to be enlarged can also be specified by
dragging with the mouse. Clicking the right mouse button shows a
reduced-size view.

 Keyboard shortcut: Zoom in [Ctrl]+[Page Down]
Zoom out [Ctrl]+[Page Up]

[View] - [Zoom] - [Custom]
command

This specifies the ratio for enlarging or reduced the view of the
object. Running this command opens the [Select Zoom] dialog
box.

[Select Zoom] dialog box

(1)
Enter the view ratio as a percentage.
Any integer from 1 to 800 can be entered.

(2)
Dragging this slider up or down changes the view ratio. Any
integer from 1 to 800 can be entered.

(1)

(2)

[View] - [Toolbar] command
This toggles the display of the toolbar on or off. The toolbar is
provided with buttons for running Dr. STIKA PLUS commands
such as [Open...] and [Save As...]. Moving the mouse pointer over
a button displays the button's name. Toggling off the display of the
toolbar enlarges the area of the edit screen.

 Related Topics
Toolbar

[View] - [Object Info] command
This toggles the display of the object information bar on or off.
The object information bar shows the position of the mouse
pointer, as well as the object's centerpoint, dimensions, angle, and
slant. Toggling off the display of the object information bar
enlarges the area of the edit screen.

[View] - [PenColor] command
This toggles the display of the color palette on or off. The color
palette is used to change the color of an object's lines Select the
object, then click on the desired palette color.

[View] - [Status Bar] command
This command toggles display of the status bar window on or off.
The status bar shows helpful comments amount commands.  We
recommend leaving the status bar on until you're familiar with
how Dr.STIKA PLUS works.
Turning off the status bar enlarges the object's display area.

[View] - [Show Grid] command
This toggles the display of the grid on or off. When Dr. STIKA
PLUS has just been installed, thee grid is shown with a spacing
interval of 5 mm (0.2 inch).

[View] - [Snap To Grid] command
When this is on, objects are automatically aligned with the grid
lines. Alignment with the grid lines can make it easier to arrange
two or more objects are make settings for object size. When Dr.
STIKA PLUS has just been installed, this function is off.
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[View] - [Grid Setup...] command

This makes the settings for grid interval, whether the grid is
displayed, and whether the snap to grid function is on or off.
Running this command displays the [Grid Setup] dialog box.

[Grid Setup] dialog box

(1)
Enter the interval for horizontally adjacent grid lines. When
Dr. STIKA PLUS has just been installed, this is set at 5.0 mm
(0.2 inch).

Setting range: 0.00 to 250.00 mm (0 to 9.84 inch)

(2)
Enter the interval for vertically adjacent grid lines. When Dr.
STIKA PLUS has just been installed, this is set at 5.0 mm (0.2
inch).

Setting range: 0.00 to 250.00 mm (0 to 9.84 inch)

(3)
This toggles the display of the grid on or off.

(4)
This toggles the function for snapping objects to the grid on or
off.

(5)
The grid is shown with dotted lines.

(6)
The grid is shown with unbroken lines.

(6)

(2)

(4) (5)

(1)

(3)
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Commands -
[Object] menu

[Object] - [Text] command
This is used to enter a block of text to be cut. Running this
command changes the mouse pointer to the text-editing tool     ( 
).Click at the point where text is to be inserted, and use the
keyboard to enter the block of text to be cut. Use the keyboard to
enter the text to be cut. The entered text is outlined, and the
outlined text is displayed. The only fonts that can be used with Dr.
STIKA PLUS are TrueType fonts registered in Windows.

It's also possible to add or delete text to or from a block of text
that has been entered.

 Related Topics
Text properties

[Object] - [Rectangle] command
This is used to create a square or rectangle by dragging to the
desired location. Running this command changes the mouse
pointer to the shape-drawing tool (  ).

 Related Topics
Rectangle properties
Creating a shape with the same vertical and horizontal aspect
Creating a shape with the drag start point as the center

[Object] - [Round Rectangle]
command

This is used to create a square or rectangle with rounded corners
by dragging to the desired location. Running this command
changes the mouse pointer to the shape-drawing tool (  ).

 Related Topics
Round Rectangle properties
Creating a shape with the same vertical and horizontal aspect
Creating a shape with the drag start point as the center

[Object] - [Ellipse] command
This is used to create a circle or ellipse by dragging to the desired
location. Running this command changes the mouse pointer to the
shape-drawing tool ( ).

 Related Topics
Ellipse properties
Creating a shape with the same vertical and horizontal aspect
Creating a shape with the drag start point as the center

[Object] - [Star] command
This is used to create a star by dragging to the desired location.
Running this command changes the mouse pointer to the shape-
drawing tool (  ).

 Related Topics
Star properties
Creating a shape with the same vertical and horizontal aspect
Creating a shape with the drag start point as the center

[Object] - [Polygon] command
This is used to create a polygon by clicking on the apices. When
finished creating the polygon, double-click on the end point.
While creating a polygon, clicking the right mouse button or
pressing [Esc] deletes the apex.

 Related Topics
Polygon properties
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[Object] - [Symbols] command
This adds a symbol to the file being edited.
Running this command opens the [Symbol] dialog box.

[Symbol] dialog box

(4)

(6) (8)

(1)
The symbol and group names appear. Click the tab and select
the group.

(2)
The name of the selected symbol is displayed. Entering a
symbol name selects the specified symbol.

(3)
A list of symbol names is displayed. Click on the name of a
symbol to select it.

(4)
A list of symbol shapes is displayed. Click on a symbol to
select it.

(5)
This deletes the selected symbol.

(6)
This changes the name of the currently selected group. The
[Change Group Name] dialog box appears. Enter the name of
the group in the dialog box.

(7)
This deletes the currently selected group. Any symbols
registered in the group are all deleted as well.

(8)
This adds the selected symbol to the file being edited.

[Object] - [Add Symbol] command

It is used to register a symbol with a Dr. STIKA PLUS object.
Running this command opens the [Add Symbol] dialog box.

[Add Symbol] dialog box

(1)

(4)

(1)
Select the group where the symbol is to be registered. Click to
display a list of existing group names. To add a new group,
click [New Group].

(2)
This adds a new group for the symbol. The [New Group]
dialog box appears. Enter the name of the group in the dialog
box.

(3)
Enter the symbol name for the selected object.

(4)
The selected object is registered as a symbol.

(1)(2)(3)

(5) (7)

(3)

(2)
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[Object] - [Properties] command
This is used to change the form of an object by modifying its
numerical values. A dialog box for changing the shape appears.
The items displayed vary according to the type of object selected.

Text properties.
Rectangle properties.
Round rectangle properties.
Circle or ellipse properties.
Star properties.
Polygon properties.

 Keyboard shortcut: [Alt]+[Enter]

[Text Properties] dialog box

(3) (2)

(1)  Height
Enter the object's height.
The height is the dimension in the vertical direction of the
screen.

(2) Width
Enter the object's width.
The width is the dimension in the horizontal direction of the
screen.

(3) Aspect
Enter the object's aspect (vertical/horizontal ratio), with the
aspect when the object was created taken to be 1. Entering a
numerical value when [Keep Aspect for input] is off causes
the [Width] dimension to increase with no change in [Height].
Entering 2 causes [Width] to double, and entering 0.5 reduces
[Width] by half. Entering a numerical value when [Keep
Aspect for input] is on makes [Width] and [Height] change
while maintaining the same aspect.

(4) Keep Aspect for input
This causes an object's aspect to be maintained at a fixed
value when a numerical value is are entered for [Height] or
[Width]. When a value is entered for [Height] (or [Width]),
the value of [Width] (or [Height]) changes automatically.

(5) Angle
Enter the angle of rotation for the object. A negative angle
may also be entered. Entering a negative angle rotates the
object clockwise.

(6) Spacing
Enter the pitch (interval) for adjacent characters. Character
size does not change.

(7) Slant
Enter the degree of slant of the object. The unit is in degrees.
Entering a positive angle makes the object slant to the right.
Entering a negative angle makes the object slant to the left.

(8) Character
Dragging the slider changes the thickness (weight) of text. A
font cannot be made narrower than its standard weight. The
left-hand end of the slider is standard weight, and the right-
hand end is maximum weight.

(9) Font
This displays the name of the selected font.
To change the font for the text, click on the down-pointing
triangle.

(10)
This setting arranges the selected text vertically or horizon-
tally.

[Rectangle properties] dialog box

(1)(5)

(6) (7) (8)

(4)

(9) (10)

(1) Height
Enter the object's height.
The height is the dimension in the vertical direction of the
screen.

(2) Width
Enter the object's width.
The width is the dimension in the horizontal direction of the
screen.

(3) Angle
Enter the angle of rotation for the object. A negative angle
may also be entered. Entering a negative angle rotates the
object clockwise.

(4) Slant
Enter the degree of slant of the object. The unit is in degrees.
Entering a positive angle makes the object slant to the right.
Entering a negative angle makes the object slant to the left.

(5)
This displays the shape of an object.

(3) (4) (5)

(2) (1)
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[Circle or ellipse properties] dialog box

(1) Height
Enter the object's height.
The height is the dimension in the vertical direction of the
screen.

(2) Width
Enter the object's width.
The width is the dimension in the horizontal direction of the
screen.

(3) Angle
Enter the angle of rotation for the object. A negative angle
may also be entered. Entering a negative angle rotates the
object clockwise.

(4) Slant
Enter the degree of slant of the object. The unit is in degrees.
Entering a positive angle makes the object slant to the right.
Entering a negative angle makes the object slant to the left.

(5) Shape
Drag the slider to change the shape of the object. Polygons
can be created.

 You can make a polygon having from three sides (a triangle)
to thirteen. Dragging the slider to the right-hand edge creates a
circle instead of a polygon.

(6)
This displays the shape of an object.

[Round rectangles Properties] dialog box

(1)

(3)

(1) Height
Enter the object's height.
The height is the dimension in the vertical direction of the
screen.

(2) Width
Enter the object's width.
The width is the dimension in the horizontal direction of the
screen.

(3) Angle
Enter the angle of rotation for the object. A negative angle
may also be entered. Entering a negative angle rotates the
object clockwise.

(4) Slant
Enter the degree of slant of the object. The unit is in degrees.
Entering a positive angle makes the object slant to the right.
Entering a negative angle makes the object slant to the left.

(5) Shape
Drag the slider to change the shape of the object.
(6)
This displays the shape of an object.

(4) (5) (6)

(2) (1)

(3) (4) (5) (6)

(2)
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[Star properties] dialog box

(1) Height
Enter the object's height.
The height is the dimension in the vertical direction of the
screen.

(2) Width
Enter the object's width.
The width is the dimension in the horizontal direction of the
screen.

(3) Angle
Enter the angle of rotation for the object. A negative angle
may also be entered. Entering a negative angle rotates the
object clockwise.

(4) Slant
Enter the degree of slant of the object. The unit is in degrees.
Entering a positive angle makes the object slant to the right.
Entering a negative angle makes the object slant to the left.

(5) Shape
Drag the slider to change the number of apices.

You can make a polygon having from three sides (a triangle)
to thirteen. Dragging the slider to the right-hand edge creates
a circle instead of a polygon.

(6)
This displays the shape of an object.

[Polygon properties] dialog box

(1) Height
Enter the object's height.
The height is the dimension in the vertical direction of the
screen.

(2) Width
Enter the object's width.
The width is the dimension in the horizontal direction of the
screen.

(3) Aspect
Enter the object's aspect (vertical/horizontal ratio), with the
aspect when the object was created taken to be 1. Entering a
numerical value when [Keep Aspect for input] is off causes
the [Width] dimension to increase with no change in [Height].
Entering 2 causes [Width] to double, and entering 0.5 reduces
[Width] by half. Entering a numerical value when [Keep
Aspect for input] is on makes [Width] and [Height] change
while maintaining the same aspect.

(4) Keep Aspect for input
This causes an object's aspect to be maintained at a fixed
value when a numerical value is are entered for [Height] or
[Width]. When a value is entered for [Height] (or [Width]),
the value of [Width] (or [Height]) changes automatically.

(5) Angle
Enter the angle of rotation for the object. A negative angle
may also be entered. Entering a negative angle rotates the
object clockwise.

(6) Slant
Enter the degree of slant of the object. The unit is in degrees.
Entering a positive angle makes the object slant to the right.
Entering a negative angle makes the object slant to the left.

(1)

(3) (4)(5) (6)

(2) (1)

(3) (4)(5) (6)

(2)
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[Object] - [Font] command

This is used to select the font for a block of text. Running this
command opens the [Font Select] dialog box. When a block of
text has been selected, this command sets its font. When no text is
selected, this command sets the font used when test is entered.

[Font Select] dialog box

(3)

(1)
This displays the selected font.
Choosing a font from the font list makes the display change.
Clicking [OK] changes the font setting to the one displayed
here.

(2)
This displays the fonts available for selection. Click on a font
in the list to choose it. Only TrueType fonts registered in
Windows are displayed.

(3)
This displays the form of the selected font.

[Object] - [Text Style] -
[Horizontal] command

The selected block text of text changes to a horizontal layout.

 Related Topics
Selecting an object hidden under another object

 Related Topics
Selecting an object hidden under another object

[Object] - [Move To Back]
command

This changes the front-back relationship of the objects. The
selected object is moved to the back.

 Keyboard shortcut: [Shift]+[Page Down]

[Object] - [Move To Front]
command

This changes the front-back relationship of the objects. The
selected object is moved to the front.

 Keyboard shortcut: [Shift]+[Page Up]

[Object] - [Align] command

All selected objects are aligned at their centers.

 Related Topics
Aligning the centers of a number of objects

[Object] - [Mirror] command

This flips an object from left to right, creating a mirror image.
This command is useful when you wish to view a sticker from its
side of application. For example, this command can be used for a
sticker to be applied to the inner side of a show window to make
sure the text and shapes are correct when viewed from the correct
side.

[Object] - [Convert to Polygon]
command

This changes the attribute for an object other than a polygon to the
attribute for a polygon. Converting an object to a polygon with
this command makes it possible for you to edit its points (apices).
Once an object has been converted to a polygon, it cannot be
returned to its original attribute (text, rectangle, rounded rectangle,
circle/ellipse, or star).

(2)

(1)

[Object] - [Text Style] - [Vertical]
command

The selected block text of text changes to a vertical layout.
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Commands - [Help]
menu

[Help] - [Contents] command

This displays the contents page for online help.

[Help] - [About...] command

This displays the version number and copyright information for
Dr.STIKA PLUS.

[Object] - [Combine Polygon]
command

A number of objects can be grouped together and united into a
single polygon. They can then be moved or resized while
maintaining the layout the objects had before they were joined
together. The points of an object polygon that has been joined
together in this fashion can be edited in the same way as an
ordinary polygon.

[Object] - [Break Apart] command

A polygon can be split into individual parts.
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Toolbar
The toolbar is provided with buttons for running Dr.STIKA
PLUS commands such as [Open...] and [Save]. Moving the
mouse pointer over a button displays a brief description of the
button's function.

This creates a new file.

This opens a Dr.STIKA PLUS file.

This saves the file, overwriting the previous
version of the file.

This takes the cutting data displayed on the edit
screen and outputs it to the cutting machine.

This deletes the selected object, and copies it to the
clipboard.

This copies the selected object to the clipboard.

This copies the contents of the clipboard, pasting
them at the selected on-screen location.

This selects an object.

This is use to move the position of a polygon's
apices, changing the polygon's shape.

This is used to enter a block of text to be cut.

This is used to create a square or rectangle by
dragging to the desired location.

This is used to create a square or rectangle with
rounded corners by dragging to the desired
location.

This is used to create a circle or ellipse by
dragging to the desired location

This is used to create a star by dragging to the
desired location.

This is used to create a polygon by clicking on
the apices.

This displays an reduced view of the object.

This changes the front-back relationship of the
objects.

This changes the front-back relationship of the
objects.

The selected block text of text changes to a
horizontal layout.

The selected block text of text changes to a
vertical layout.
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If You Think There's
a Problem...

Dr.STIKA PLUS doesn't
function.

Does the computer you're using
provide the correct operating envi-
ronment for Dr.STIKA PLUS?

Check the conditions for the Dr.STIKA PLUS operating environ-
ment and make sure that the computer offers a suitable environ-
ment.

Was the software installed using
the setup program?

The setup program puts the files for Dr.STIKA PLUS in the
necessary locations to enable the software to be used under
Windows.

Uncut areas remain, or
areas are not cleanly cut.

Is the amount of blade extension
correct?

The amount of blade extension that has been set is too short for the
material being used.  Increase the extended length of the blade to
the same thickness as the sheet portion.  For information on how to
adjust the amount of blade extension, refer to the user's manual for
the cutting machine.

The blade may be broken.

Replace with a new blade.
For information on how to replace this, refer to the user's manual
for the cutting machine.

No circles or triangles (  or
 ) are displayed around

objects.

If you're using Windows 98 or 95, then depending on the com-
puter model, the circle and triangle symbols for manipulating
objects may not appear.
In such cases, you can work around the problem by following one
of the methods below.
* The following procedure involves the overall operating

environment of the computer. Changing the settings also
affects operations other than Dr. STIKA PLUS.
When making the settings, see the help for Windows as well.
You can view help for Windows by right-clicking with the
mouse in the corresponding dialog box.

Workaround 1
1. Click [Start].

Point to [Settings] to display Control Panel.
2. Double-click the [Display] icon, then click [Settings].
3. Set [Colors] to [256 Colors], then click [OK].

Workaround 2
1. Click [Start].

Point to [Settings] to display Control Panel.
2. Double-click the [System] icon, then click [Performance].
3. Click [Graphics].
4. Move the [Hardware acceleration] bar to the left until the

circle and triangle symbols (  and ) around the objects
appear.
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Unexpected file format

A file opened with the [Open] command or imported with the
[Import] command is in a format that Dr. STIKA
PLUS does not recognize.  Use a file format that Dr. STIKA PLUS
can recognize.

File formats that can be imported

Windows Bitmap:
Extension *.bmp ([Import] command only)

Dr.STIKA PLUS:
Extension *.stx

 Related Topics
Using a scanner to import an object
Importing bitmap data

Error Messages

XXXXX Illigal Font Select

The Dr. STIKA PLUS file you tried to open contains fonts that are
not registered in Windows.  When this happens, a list of substitute
fonts is displayed.  The file may have been made on a machine
with a different font environment, or some fonts may have been
deleted from Windows.  To reproduce the original image, make
sure the necessary fonts are installed.

Not enough memory

If insufficient memory occurs during processing, close all other
applications or restart Windows.
If the message about insufficient memory still appears, check the
amount of free space on your hard disk.  Windows normally uses a
portion of the hard disk for virtual memory, and it may be that
there is not enough space left on the hard disk.  If this is the case,
free up space on the hard disk by deleting unneeded files or
moving them to another disk.  If the message about insufficient
memory still appears after doing this, it is recommended that you
increase the amount of memory in your computer.

Could not generate outline

An outline could not be extracted because of the faint color of data
imported using a scanner or Windows bitmap data imported with
the [Import] command.  Adjust the data to a darkness that allows
an outline to be extracted and import the data again.

The results of cutting are
displaced, and uncut
portions

Is the amount of blade extension
correct?

The amount of blade extension that has been set is too long for the
material being used. Increase the extended length of the blade to
the same thickness as the sheet portion.  For information on how
to adjust the amount of blade extension, refer to the user's manual
for the cutting machine.

Is the cutting speed correct?

The cutting speed is too fast.  Change the driver setting to obtain a
slower cutting speed.  Please refer to the relevant help screens for
the driver to set the cutting speed.

Has the material size been set cor-
rectly?

Material smaller than the set cutting range has been loaded.  Load
material that matches the cutting range.
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Object

This is the collective name for shapes and blocks of text. The lines
which are actually cut are displayed.

Dr.STIKA PLUS file

This is a file saved in Dr. STIKA PLUS format. Normally the file
extension ".stx" is used for such files.

Windows bitmap (BMP)

BMP (Windows bitmap) is a standard graphical file format for
Windows. It can be used to store bitmap data. All graphics are
represented as a collection of dots.

TrueType font

This is one type of outline font system that represents text as an
outline and a filled portion.  It is provided as standard on Windows
95.

Vector data

Vector data is a data format that represents images (text and
shapes) as a set of reference points and the lines that connect them.
Most draw-type software applications can be used to create vector-
data images.

Bitmap data

Bitmap data is a data format that represents images (text and
shapes) as a collection of dots.  Most paint-type software applica-
tions show images as bitmaps.

Resolution

This is a scale that indicates the precision of images displayed on
screen, printed on the printer, or acquired with the scanner.  The
larger the number, the more detailed and attractive is the image it
represents.

Gradations

This indicates the smoothness of changes in color when colors are
used.

Clipboard

The clipboard is used to hold data temporarily when it is being
copied or cut.  The clipboard is a standard feature of Windows 95.

Glossary
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Index

A

[About...] command ..................................................................... 36
[Acquire...] command .................................................................. 26
[Add Symbol] command ............................................................. 31
[Align] command ........................................................................ 35
Apex ............................................................................................ 15

Add ........................................................................................ 16
Delete .................................................................................... 16
Move ...................................................................................... 16
Select ..................................................................................... 15

B

Basic operations for editing a polygon ........................................ 15
Bitmap data ........................................................................... 19, 42
BMP ............................................................................................... 4
[Break Apart] command .............................................................. 36

C

Choose a font ................................................................................. 9
[Circle or Ellipse] command ....................................................... 30
[Circle or ellipse properties] dialog box ...................................... 33
Clipboard ....................................................................... 19, 27, 42
[Combine Polygon] command ..................................................... 36
Commands ................................................................................... 23
[Contents] command ................................................................... 36
[Convert to Polygon] command .................................................. 35
[Copy] command ......................................................................... 27
Could not generate outline .......................................................... 40
Creating regular polygons ........................................................... 18
[Cut] command ............................................................................ 27
Cutting area .............................................................................. 5, 7
Cutting conditions ......................................................................... 8
Cutting direction ............................................................................ 5

D

[Delete] command ....................................................................... 27
Dialog box

[Add Symbol] ........................................................................ 31
[Circle or ellipse properties] .................................................. 33
[Grid Setup] ........................................................................... 29
[Open] ............................................................................. 24, 25
[Polygon properties] .............................................................. 34
[Rectangle properties] ........................................................... 32
[Round rectangles Properties] ............................................... 33
[Save As] ............................................................................... 25
[Select Zoom] ........................................................................ 28
[Star properties] ..................................................................... 34
[Symbol] ................................................................................ 31
[Text Properties] .................................................................... 32
Font Select ............................................................................. 35

Dr.STIKA PLUS doesn't function. .............................................. 39
Dr.STIKA PLUS file ................................................................... 42

E

[Edit] menu .................................................................................. 27
Editing the points (apices) of a polygon ...................................... 15

Enter the text ................................................................................. 8
Error messages ............................................................................ 40
[Exit] command ........................................................................... 26

F

[File] menu .................................................................................. 24
[Font] command .......................................................................... 35

G

Gradations ..................................................................... 20, 21, 42
[Grid Setup...] command ............................................................. 29

H

[Help] menu ................................................................................. 36
Hints and tips ............................................................................... 13

I

[Import] command ....................................................................... 25
Importing a symbol ..................................................................... 18
Importing bitmap data ................................................................. 21

M

Making an object larger or smaller .............................................. 11
Menu Bar ....................................................................................... 5
[Mirror] command ....................................................................... 35
[Move To Back] command .......................................................... 35
[Move To Front] command .......................................................... 35

N

Names and Functions of Screen Items .......................................... 5
[New] command .......................................................................... 24
Not enough memory .................................................................... 40

O

Object
Arranging .............................................................................. 17
Basic Operations ................................................................... 10
Change the size ...................................................................... 11
Copy ...................................................................................... 12
Delete .................................................................................... 12
Move ...................................................................................... 11
Rotate .................................................................................... 12
Select ..................................................................................... 11
Slant ....................................................................................... 12

[Object Info] command ............................................................... 28
Object information bar .................................................................. 5
[Object] menu .............................................................................. 30
Objects

Aligning the centers .............................................................. 17
[Open...] command ...................................................................... 24
Operating environment .................................................................. 4
Operating procedure ...................................................................... 6
Outputting data larger than the cutting area ................................ 22
Overview ....................................................................................... 4
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P

[Paste] command ......................................................................... 27
[PenColor] command .................................................................. 28
Performing a draft plot ................................................................ 22
[Polygon] command .................................................................... 30
[Print Preview] command ............................................................ 26
[Print Setup...] command ............................................................. 26
[Print...] command ....................................................................... 26
[Properties] command ................................................................. 32
Purge print Jobs ............................................................................. 9

R

[Rectangle] command .................................................................. 30
[Rectangle properties] dialog box ............................................... 32
Registering a symbol ................................................................... 18
Resolution ...................................................................... 20, 21, 42
[Round Rectangle] command ...................................................... 30
[Round rectangles Properties] dialog box ................................... 33

S

[Save] command .......................................................................... 24
[Save As...] command .................................................................. 25
Save the file ................................................................................... 9
[Select All] command .................................................................. 27
[Select Source...] command ......................................................... 26
[Select Zoom] dialog box ............................................................ 28
Selecting a segment ..................................................................... 15
[Show Grid] command ................................................................ 28
[Snap To Grid] command ............................................................ 28
[Star] command ........................................................................... 30
[Star properties] dialog box ......................................................... 34
Status Bar ...................................................................................... 5
[Status Bar] command ................................................................. 28
Symbol

Importing ............................................................................... 18
Registering ............................................................................ 18

[Symbol] dialog box .................................................................... 31
[Symbols] command .................................................................... 31

T

[Text] command ........................................................................... 30
[Text Style] - [Horizontal] command .......................................... 35
[Text Style] - [Vertical] command ............................................... 35
[Tiling] command ........................................................................ 26
Title bar .......................................................................................... 5
To cancel cutting ............................................................................ 9
Toolbar .................................................................................... 5, 37
[Toolbar] command ..................................................................... 28
Toolbar buttons ............................................................................ 37
TrueType font .................................................................. 9, 35, 42
Tutorial .......................................................................................... 6

U

[Undo] command ......................................................................... 27
Unexpected file format ................................................................ 40
Using a scanner to import an object ............................................ 20
Using grid .................................................................................... 17
Using snap ................................................................................... 17

V

Vector data ............................................................................ 19, 42
[View] menu ......................................................................... 24, 28

W

Windows bitmap ................................................................... 21, 42

X

XXXXX Illigal Font Select ......................................................... 40

Z

[Zoom In] command .................................................................... 28
[Zoom Out] command ................................................................. 28
[Zoom] - [Custom] command ...................................................... 28
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